User’s Manual

National Health Accounts

Peter A. Berman
David M. Cooper

Software for Windows 95
Version 1.01
Registering National Health Accounts

Version 1.01 is the first complete edición of the National Health Accounts. We hope to make many future enhancements and improvements in the product. In order to contact you with new developments about National Health Accounts, we need to know who and where you are.

In order to register, please fill out the form at the end of the manual and send it to:

National Health Accounts
Building I, Room 1210
Department of Population and International Health
Harvard School of Public Health
665 Huntington Ave.
Boston, MA 02115

or e-mail this information to: pberman@hsph.harvard.edu

For more copies of this manual, please contact:

PHR Resource Center
Abt Associates Inc. Suite 600
4800 Montgomery Lane
Bethesda, Maryland USA 20814
Fax: 301-652-3916
E-mail: PHRInfo-Center@abtassoc.com

Copyright © 1996 by Peter A. Berman and David M. Cooper.

Dr. Peter Berman, the copyright holder, grants to the United States Government and others acting on its behalf, a paid up, nonexclusive, irrevocable worldwide license to reproduce, prepare derivative works, and perform publicly and display publicly, by or on behalf of the Government. This license is granted under USAID Contract No. DPE-5991-A-00-1052-00, the Data for Decision Making Project.
Acknowledgements

Harvard University School of Public Health

The methodology behind National Health Accounts (NHA) was developed by Peter A. Berman, Ph.D., associate professor of International Health Economics at the Harvard School of Public Health. The software was written by David M. Cooper, an independent software developer and co-founder of Multitrak Software Development Corporation. The manual and help text were written by Amanda Glassman, Peter A. Berman, Ravindra Rannan-Eliya, and David M. Cooper.

The development of the software was greatly assisted by the staff at the United States Agency for International Development (USAID)-funded Data for Decision Making (DDM) Project implemented by Harvard School of Public Health, in particular, Chris Hale, Christina Oltmer, and Kristen Purdy. Dr. Ravindra Rannan-Eliya collaborated extensively on the early development and application of the methodology.

Egypt

The Egypt example used in the software represents the work of numerous colleagues at the Department of Planning of the Ministry of Health, Arab Republic of Egypt, led by Dr. Moshira El Shafei. A.K. Nandakumar, Ph.D., health economist at the Harvard School of Public Health, provided substantial support for this effort while DDM resident advisor in Egypt.

Latin America and Caribbean Initiative for the Development of National Health Accounts

The authors wish to acknowledge the founding participants in the development of the Latin America and Caribbean Regional Network on National Health Accounts sponsored by the Partnerships for Health Reform (PHR) Project and the Pan American Health Organization (PAHO) with technical assistance from FUNSALUD in Mexico. The network is composed of multi-ministerial teams from the governments of Bolivia, the Dominican Republic, Ecuador, El Salvador, Guatemala, and Nicaragua. The participation of Peru was made possible by support from the British Overseas Development Administration. The NHA methodology and software has benefited from their feedback on its application in their respective countries.
United States Agency for International Development

At USAID, Dr. James Sheppard, Ms. Katie McDonald, Mr. Robert Emrey, Mr. Forest Duncan, Ms. Suzzane McQueen, and others have provided substantial support and encouragement. The Latin America and Caribbean Regional Network initiative, conducted in collaboration with PAHO, received generous support and funding from Carol Dabbs of USAID's Bureau for Latin America and the Caribbean.

NHA has been developed and applied through the generous support of USAID Cooperative Agreement No. DPE-5991-A-00-1052-00, the DDM Project, and further refined, translated, and distributed under Contract No. HRN-5974-C-00-5024-00, the PHR Project.
Table of Contents

Preface ........................................................................................ vii
Introduction: How to Use this Manual ......................................... xiii
Chapter 1: What are National Health Accounts ......................... 1
  1.1 Policymakers and Health Expenditure Data .......................... 1
  1.2 The National Health Accounts Framework and Software ....... 1
  1.3 Generating Estimates for the Matrices ................................. 3
  1.4 The Eight Substeps of the NHA Analysis ............................ 4

Chapter 2: How to Install National Health Accounts .................. 7
  2.1 Hardware and Software Requirements ............................... 7
  2.2 Installing National Health Accounts .................................. 7
    2.2.1 Windows 95 Installation ............................................. 8
    2.2.2 Windows 3.1 Installation ............................................ 9
    2.2.3 Manually Changing AUTOEXEC.BAT ........................ 10

Chapter 3: How to Use the National Health Accounts Program ......11
  3.1 Starting the Program ......................................................... 11
  3.2 What is a Project? .............................................................. 12
  3.3 Creating a New Project ..................................................... 12
  3.4 The Country Profile Screen ................................................. 13
  3.5 The Step by Step Menu .................................................... 15
  3.6 Opening a Project File ....................................................... 16
    3.6.1 The Last Accessed List on the File Menu .................... 16
    3.6.2 Finding a Project on Disk ............................................ 16
  3.7 The Sample Project: The Egyptian Health Care System ....... 17
  3.8 Saving Data ................................................................. 17
    3.8.1 Automatic Saving .................................................... 17
    3.8.2 Save As ................................................................. 17
  3.9 Closing a Project File ....................................................... 18
  3.10 Leaving the Program ....................................................... 18
  3.11 Help ........................................................................... 18
Chapter 4 : How to Use the Basic Elements of National Health Accounts 19

4.1 Main Windows ................................................................. 19
4.2 A Tour through the NHA Methodology .............................. 21
   4.2.1 Substep 1: Choose Entities ........................................ 22
   4.2.2 Substep 2: Define Flow .............................................. 24
   4.2.3 Substep 3: Detail Flow Diagram .................................. 25
   4.2.4 Substep 4: Full Flow Diagram: .............................. 26
   4.2.5 Substep 5: Estimate Matrix ........................................ 27
   4.2.6 Substep 6: Graphs ....................................................... 30
   4.2.7 Substep 7: Matrix Bar Graph ...................................... 31
   4.2.8 Substep 8: Checks and Reports ............................ 32
4.3 The Choose Value to Display window .............................. 34
4.4 Other Helpful Information .............................................. 36
4.5 Other Windows ............................................................. 36

Chapter 5: How to Use Other Matrices of National Health Accounts 37

5.1 Matrix II: Financing Agents to Providers .......................... 37
5.2 Matrix III: Financing Agents to Functions ....................... 37
5.3 Matrix IV: Financing Agents to Line Items ..................... 38
5.4 Matrix V: Other Matrices ................................................ 38

Chapter 6: How to Print and Export Information ........................ 39

6.1 Printing ................................................................................. 39
   6.1.1 To access the printing options .................................... 39
   6.1.2 Report Print Preview window ..................................... 39
   6.1.3 Report Print Preview toolbar ..................................... 40
   6.1.4 Printing Graphs .......................................................... 41
   6.1.6 Printing Matrix Diagrams ....................................... 41
6.2 Exporting Report Data ...................................................... 43

Chapter 7 : How to Use National Health Accounts Tools ............ 45

7.1 Settings .............................................................................. 45
7.2 Database Compacting and Repair .................................. 46
   7.2.1 Compacting Projects ............................................ 46
   7.2.2 Repairing Projects ................................................. 46

Annexes .................................................................................. 47

Glossary .................................................................................. 47

Acronyms .................................................................................. 48

Selected Bibliography: References for National Health Accounts .... 49
Policy Uses of National Heath Accounts

National Health Accounts (NHA) are a powerful tool that can be used to improve the capacity of decision makers to identify health sector problems and opportunities for change and to develop and monitor reform strategies.

The use of national health expenditure accounts in policy making is a recent phenomenon. This section will review NHA policy research and some of its policy uses in Egypt, Jordan, the Philippines, and the United States. We will also look at the policy relevance of cross-national analyses based on the experience of the Organization for Economic Cooperation and Development (OECD) countries. While these examples illustrate the importance of NHA data for policy making, they also show that national health expenditure analyses, like any research, can be misused, misinterpreted, and/or disregarded.

Egypt

In Egypt, a first-round estimation of NHA was initiated through donor funding. On the release of the NHA estimates, Egyptian policymakers and donors alike used the estimates for advocacy and planning purposes. Having appreciated the utility of the figures, second- and third-round estimation was requested by the government of Egypt.

The 1995 Egypt NHA showed that total public financing came to 1.8 percent of gross domestic product (GDP), while private financing contributed almost double, 2.7 percent of GDP. While such a level of public expenditures on health is relatively high in comparison with countries at a similar income level, private expenditures are much higher than in the majority of countries for which accurate data exist. As a percentage of GDP, Egypt generates more private financing for health than most other countries, at least when the whole health system is considered, suggesting that the perception of Egypt as a country with a relatively low level of cost recovery in its health sector is untrue.

The analysis of public expenditure conducted as a part of NHA also yielded interesting results. Overall Ministry of Health (MOH) expenditures increased 14 percent in real terms, equivalent to a 5 percent increase in real per capita funding over four years. During this
same time period, the governorate share of actual MOH expenditures declined from 89 percent to 75 percent, owing to a significant increase in the share of resources allocated at the MOH headquarters level. Consequently, on a real per capita basis, the amount of resources directly allocated to most governorates fell substantially.

**Jordan**

A health sector study conducted in Jordan estimated the financial effects of several reform proposals using National Health Accounts as a point of departure. The government of Jordan wished to consider proposals for universal health care coverage for its citizens, while the financer of Jordan’s health reform planning wished to explore the financial effects of such a policy change. Consultants assessed the probable financial impact of the various policy options, which included the expansion of the current subsidized care and cost-sharing system within the MOH, the expansion of the Social Security Corporation, and/or the implementation of employer mandates or other national approaches (for example, sickness funds or general revenue financed systems).

The analysts first chose a base year for the NHA analysis and projected forward or backward depending on the data available. Once a base year NHA had been developed and expenditures that would not be affected by the policy change omitted from the matrix (such as public health services), the researchers attempted to quantify the changes in spending that would occur as the result of each policy option. These anticipated changes served as the basis for the adjustment of the figures in the base year NHA matrix.

Expenditure changes that occurred as the result of the reforms were generated through the adjustment of the base year NHA matrix along three axes: induction, payment rates, and efficiency. The induction impact of a reform is the change in total spending caused by a change in the out-of-pocket expenses associated with receiving services through universal coverage, or, more broadly, the changes in total expenditure that are induced by other changes in expenditure that occur as the result of a system change. A second set of adjustments was made as the result of changes in payment rates or protocols. Finally, the matrix was adjusted according to the reforms’ impact on efficiency (if any). For example, a reform that shifts services from overcrowded facilities to underutilized facilities may raise efficiency, which may in turn affect expenditure estimates among the various providers.

While providing some interesting indicative results for health policy decision makers, the Jordan study was done quickly, with available figures. The study only examined changes in expenditures that would have an impact on government expenditure patterns, while paying insufficient attention to the under-studied private sector. More sustained national efforts are needed to strengthen the completeness and accuracy of the analysis. The study’s use of NHA as a starting point provided a framework for integrating data and assumptions consistently. The NHA framework
allowed analysts to watch the whole system while modeling the impact of reform and making explicit adjustments for any factors needed.

The Philippines

With funding from international financial institutions, the University of the Philippines School of Economics and the Department of Health (DOH) undertook the estimation of National Health Accounts. The collaborators were able to specify the continuation of NHA beyond the project life and institutionalize the collection of NHA data within the DOH. The group also initiated the development of provincial health accounts.

Findings from the 1991 estimation generated considerable debate in the Philippine legislature in February 1995 around the low percentage of expenditure and coverage of social insurance schemes (12 percent of the total expenditure) and the relatively high level of government expenditure (44 percent). Unfortunately, legislators responded to these figures by passing a bill to expand social insurance without performing any of the requisite financial analyses, which has resulted in a financially unsustainable insurance scheme (Herrin, 1996).

The Filipino NHA team, recognizing the limitations of a single-year estimate of NHA, employed a policy simulation methodology in order to sustain interest around the NHA as a tool for analyzing health care policy (Solon and Tan, 1996). This model defines the underlying elements of each NHA cell and varies them according to historical patterns and other special studies in order to simulate the effects of socialized pricing of publicly provided services. The results of the simulation showed that total health care spending would increase with socialized pricing (income-based discriminatory pricing). As public services prices increase, wealthier groups shift to more expensive private services. Nonetheless, the revenue gain from the wealthier consumers who continue to use public services more than compensates for the increased subsidy required for poor consumers. As government facilities practice income-based price discrimination, reliance on public and private insurance coverage increases. Finally, out-of-pocket expenditures also increase as richer income segments increasingly access private sector services. According to Herrin, the simulation gave policymakers answers to their “what if” questions, allowing for data instead of speculation to fuel policy debates.

The simulation was demanding in terms of data. The NHA team used three national sample surveys: a special survey of households, hospitals, and outpatient clinics; the Family Income and Expenditures Survey; and the National Health Survey. However, for data-poor countries, a simpler version of the same model could be utilized effectively.

Under a United States Agency for International Development (USAID)-supported project, the Filipinos were also able to estimate national family planning expenditures within an NHA framework, finding that donors accounted for approximately 35 percent of all funding for family planning activities, more than the government itself. Further, the
flow of funds study showed that the great majority of these funds were absorbed into the administrative expenses of USAID and their cooperating agencies. These findings should have great significance to the sustainability of the donors’ efforts.

**United States**

Since 1964, the Health Care Financing Administration (HCFA) of the U.S. Department of Health and Human Services has published an annual series of statistics describing total national health expenditures for each year. HCFA is regularly called upon to report on emerging expenditure patterns and problems and to model the financial effects of policy reforms under consideration in the executive branch and in the legislature. HCFA attempts to remain close to current policy debates in the U.S. legislature through the release of a seasonal journal, the *Health Care Financing Review*, and frequent publications in other health policy journals, such as *Health Affairs Data Watch*. The U.S. NHA remains close to its users through periodic evaluations of sources, definitions, and categories, and frank, critical review of estimates generated. HCFA's NHA estimates serve as the basis for the U.S. government’s submission to the OECD health expenditure data banks, being considered more reliable and detailed than health expenditure estimates generated through the National Income Accounts. In combination with the OECD’s work, the U.S. NHA is the model for the institutionalized collection of national health expenditure data—the NHA serves as both a generator of policy debate and an evaluator of policy instruments. Only one further application of NHA will be highlighted here: interested readers should refer to Lazenby et al (1992) for more information on the NHA system.

Of potential interest to increasingly decentralized governmental systems, HCFA has recently promoted the policy use of state health expenditure accounts. The current effort to develop and expand state health expenditure accounts began during the 1993-94 health reform debate, as policymakers began to question the effect of national policy options on individual states. Those health reform efforts failed; subsequently, the focus shifted to the efforts of the states to grapple with the continued rise in the number of uninsured, lack of availability of health insurance to many employed workers, mandated Medicaid and Medicare expansions, state budget constraints, aging populations, and uncompensated care. Several states, such as Oregon and Florida, independently implemented major reforms in their health systems.

State-level expenditure estimates are instrumental in measuring the differential impact of federal policies and state-specific initiatives on individual states. Personal health care expenditures were examined over a 13-year period and these figures showed wide variation in level and rate of growth of regional spending per person. These statistics were also able to quantify differences in both the percent of health care costs in each state borne by Medicare and Medicaid and in the proportion of each state’s economy devoted to the provision of health care.
Cross-national Comparisons: the OECD Countries.

The OECD Health Data File is the first attempt to compile and process official data on national health expenditures at the international level. OECD analysts use readily accessible information from constituent countries and adjust this data to produce comparable units. Given the heterogeneity of data and classification systems among OECD nations, analysts have focused on reductionist aggregates that can be reasonably compared. These include total expenditure on health; public expenditure on health; total and public expenditure on inpatient care; total and public expenditure on ambulatory medical services; total and public expenditure on pharmaceutical goods; and public expenditure on capital goods for medical care. In addition, the OECD calculates price indices for inpatient care, ambulatory medical care, and pharmaceutical goods; and an aggregate index of medical care and health services with which to adjust estimates for comparison purposes. OECD also looks at social protection (coverage of different costs) and public participation (government’s share of billing for inpatient and ambulatory care); utilization of medical services and available personnel resources; selected variations in common medical care practice; selected health status indicators (life expectancy and mortality rates); and demographic and general economic background data (Poullier, 1990).

The OECD data base has generated a substantial number of further analyses. The OECD itself has compared health systems through levels and trends in relative (share of GDP) and absolute spending analyzed through share of GDP; percentage change in relative and nominal per capita health spending compared to relative and nominal per capita GDP; and comparisons in absolute levels of health spending through the use of GDP Purchasing Power Parities (PPP).

Health expenditure trends have also been decomposed to show excess health care inflation and increases in volume-intensity (utilization) per capita, the two basic endogenous factors driving health expenditure change. These analyses rely on valid information on health care prices and overall health spending. The OECD uses price indices based on extant indices for individual countries and does not adjust for productivity changes over time.

The OECD has made cross-national comparisons on the income of health care professionals, which accounts for two-thirds or more of health expenditure and shows large behavioral differences between countries.

In more recent publications, the OECD builds on the well-known relationship between recorded expenditure on health per capita and income per capita to generate expected spending at given income levels. The analysis is conducted on over 30 years of data expressed in PPPs for the OECD nations. Interestingly, particularly for developing countries, the expected level of health spending in the lower-income-per-capita countries appears to be broadly that of today’s wealthier
countries when they had income levels similar to today’s lower-income OECD countries (an intransigent outlier is the United States). While this finding is interesting in the aggregate, improved data now allow for correlations between each subaggregate spending function and total national expenditure in order to compare the efficiency of different national spending patterns.

Increasingly comparable categories of inpatient care, ambulatory medical services, pharmaceutical goods, and therapeutic appliances have generated comparisons of medical consumption by function. Work has been done in the comparative evaluation of health outcomes produced by health systems. Finally, analysts have been able to evaluate population satisfaction as a function of health spending.

The comparative analyses of the OECD provide another perspective on NHA and its uses and also serve as a model for future international collaboration. It is only in relation to other nations’ health systems that any one national system be judged as efficient or equitable. For example, it was in contrast to the other OECD countries that exorbitant U.S. spending on health became recognized in its full dimensions.
How to Use this Manual

This manual is divided into four main parts, each with a different purpose.

Overview

The Preface addresses the policy uses of National Health Accounts and, with Chapter 1, provides an overview and context for the National Health Accounts methodology and software. How can it help you analyze the flow of funds in your country's health care system? Why should you use National Health Accounts? What do you need to perform your analysis successfully?

Getting Started

Chapter 2 helps you install the program and become familiar with how to use the essentials of the program. If you are unfamiliar with how Windows-based programs work, you may want to consult the Getting Started manual that is shipped with Microsoft Windows before you attempt to install or use National Health Accounts.

Basic Skills

Chapter 3 covers the National Health Accounts method in greater detail and describes how to use the different data entry windows.

Advanced Skills

Chapter 4 explains how to use the more complicated aspects of National Health Accounts through a guided tour of the first matrix, Sources to Financing Agents. Chapter 5 looks at other matrices. Chapters 6 explains how to print and export your data, Chapter 7 how to handle the program's special tools.

Examples

This manual uses a National Health Accounts project, the Egyptian Health Care System, to illustrate procedures described in the text. This file, EXAMPLE.NHA, is shipped as part of the installation. It is included as a common reference point for the manual and for users who seek to apply National Health Accounts.
Who Can Use This Manual

This software is intended to be a tool for developing country analysts and decision makers in the development of a regular system of NHA.
What are National Health Accounts?
1.1 Policymakers and Health Expenditure Data

In the health sector, as in any sector, the resources available to meet national goals are limited. In the past several decades, this scarcity of financial resources in the health sector has increasingly led countries to take stock of national health resources used, review allocation patterns, assess the efficiency of existing resource use, and study and evaluate health financing options. The primary difficulties in undertaking these analyses have been (1) the lack of information on health expenditures and (2) not using existing information to improve the planning and management of health sector resources.

For many years, a variety of guidelines and formats have been proposed for the collection of national health expenditure data in the public and private sectors (Abel-Smith, 1963, 1967; Zschock et al, 1977; Griffiths and Mills, 1982; Mach and Abel-Smith, 1983; Newbrander et al, 1994). Some argue that the information be collected as an extension of national income accounting (Abel-Smith, 1963, 1967; Foulon, 1982; Cumper, 1986). Others advocate using elements of national income accounting in order to preserve compatibility while still preparing separate estimates for the health sector for use in policy making (Berman and Rannan-Eliya 1993; Berman, 1996; Waldo, 1996). Most authors, however, agree that a standard set of health activities definitions and expenditure categories across countries would increase the utility of the information for both national and international policymakers and analysts. Standard organization, tabulation, and presentation of data will also enhance the policy relevance of health expenditure information.

1.2 The National Health Accounts Framework and Software

A National Health Accounts (NHA) framework is one way to organize, tabulate, and present health sector expenditure information. The experience that the United States and the nations of the Organization for Economic Cooperation and Development (OECD) nations have had with the NHA methodology shows that the NHA
matrices can highlight policy problems, enhance cross-country comparability, and thus increase the likelihood that data collection efforts will be repeated regularly.

The Harvard NHA software was developed in 1996. However, variants of the NHA methodology have been utilized in the United States and the OECD countries for the past 20 years.

The NHA framework elaborated in this software package is designed to capture the totality of expenditure flow in the health sector. The framework does not include standard definitions and categories—these must be determined through a combination of national and international discussions and consensus about priorities. It does, however, provide an analytical framework consisting of three essential elements: First, it requires the calculation and presentation of national estimates through a “sources and uses” matrix. Second, it allows for extensive disaggregation of the sources of spending beyond the general categories of “public” and “private.” Third, it provides a systematic framework for defining uses according to several important, and mutually exclusive, classifications.

The “sources and uses” method imposes an important discipline on national health expenditure analysis, which typically consists of separately compiled estimates of expenditures by sources and by types of providers, e.g., hospitals and doctors. The matrix approach requires that all expenditures estimated by the different sources be allocated to specific uses, for example, all spending on government hospitals must be traceable to the specific sources. The totals and subtotals must add up and be consistent. The software ensures this outcome through a series of consistency checks and reports.

The matrix requires analysis not only of the subtotals and their aggregates, but also an understanding of the flow of funds through the health care system. It stresses the need to know in an integrated way who pays, how much, and for what, rather than simply separating the who from the what. For this reason, the NHA methodology includes an intermediate category, “financing agents,” that allows for the division between the financing and provision of services. The software is able to display this information both in a matrix and a graph. The flow of funds charts allow the user to view the financing and provision arrangements in a health systems in one glance.

This capability of linking sources and uses is an important aspect of the value of NHA for analyzing health care financing policies. This is because health financing is not solely concerned with raising funds for the health sector, but also plays an important role in determining the allocation of expenditures and the behavior of providers and consumers. Policies that affect the practice of the financiers of health care (the sources) need to be designed, monitored, and evaluated in terms of their influence on the uses of funds in the health sector both in terms of who receives them and what they produce as a result. The “sources and uses” method is the means to that end.
In addition, the software is sufficiently flexible to allow for a variety of matrix presentations. First, the program allows the traditional NHA analyses: sources to financing agents and financing agents to providers. It then includes frameworks for the analysis of expenditure flows from financing agents to specific functions and line items. Finally, the program includes empty matrices that can be used for additional descriptive analyses, such as the flow of funds from financing agents to provinces or states in a decentralized system or from financing agents to socioeconomic classes in an assessment of equity.

The NHA software is thus a tool that can be used to organize, describe, and present expenditure data. In addition, the software is intended to support analysts and policymakers in their data collection and analysis and in their advocacy efforts with decision makers. The program’s graphical capabilities allow policymakers to view the structure of health sector financing flows clearly and quickly.

### 1.3 Generating Estimates for the Matrices

The NHA software provides a framework for the analysis of the data collected and helps keep track of data sources and quality. However, generating estimates for the matrices is a task that remains to the analyst. A technical annex to this manual will review the common methods and sources for the generation of estimates from the public and private sectors and their strengths and limitations. In general, the method relies on existing data sources. NHA does not require much complex calculation to fill in and complete the sources and uses matrices, although multivariate analysis of household or health facility data might be useful for determining specific coefficients used in allocating certain expenditure items to different types of uses.
A common starting point for every user, however, should be the definition of the health sector, i.e., the definition of what will be classified as health expenditure. This will govern what is included and excluded from the matrix estimates. Within the NHA methodology, as presented in this program, the health sector is defined as “expenditure on activities whose primary intention (regardless of effect) is to improve health” (Griffiths and Mills 1993). As the border between what are considered primarily health expenditures and what are primarily expenditures for other purposes is blurred—for example, expenditures on family planning programs, food subsidy programs, and basic housing, might have various purposes—it is vital to be clear about the primary purpose of each expenditure. For this reason, the individual analyst or policymaker must make explicit which categories to include in or exclude from the NHA methodology.

The software user should recognize that sources and methods used to generate estimates will depend on the resources of each individual country.

1.4 The Eight Substeps of the NHA Analysis

The NHA software guides you through the five main matrices. The matrices correspond to the five main buttons on the Step by Step screen. The first step is to choose a matrix; you can fill out each matrix in a linear fashion or start with the matrix that interests you and move backwards or forwards. However, some substeps (such as the Estimate Matrix) require that you complete a previous substep (such as Choose Entity) in order to carry out an analysis.

Each matrix analysis comprises eight substeps:

**Substep 1 - Choose Entities**

Defining entities is a critical first step in the analysis. (An “entity” is any organization, group, or type of use of funds employed in this analysis of expenditures.) The program asks that you develop a complete but practical categorization for all sources, financing agents, and uses in the health system. Country-specific definitions and categories are an important component of this list. Each entity must be well defined and mutually exclusive from all other entities. The program has both built-in standard entities and space to add your own entities. Typical sources are ministries of finance, international assistance, employers, and households/individuals. Typical financing agents are ministries of health and education, other ministries, social insurance, private insurance, firms, and households. And typical providers are ministries of health, teaching and university hospitals, other public institutions, social security agencies, nongovernmental organizations, private medical providers, pharmacies, and/or other private providers.
Substep 2 - Define Flow

The program asks you to identify all the places where there is a flow of funds from a source to a financing agent and from a financing agent to a use/provider. These sites of the flow of funds will become the cells to be filled—the NHA matrices.

Substep 3 - Detailed Flow Diagram

The Detailed Flow substep takes the information you have entered in the Choose Entities screen and graphically displays the flow of funds between a single entity source and various financing agents.

Substep 4 - Full Flow Diagram

The Full Flow Diagram substep graphically displays the funding flows from all sources to all financing agents, or from all financing agents to all providers.

Substep 5 - Estimate Matrix

The Estimate Matrix allows you to input data through the Flow Detail or Quick Entry windows and construct a matrix for each level of analysis. This data will serve as the basis for consistency checks across matrices and for graphic displays.

Substeps 6 and 7 - Graphs and Matrix Bar Graph

The Graphs and the Matrix Bar Graph substeps allow you to display the data collected in a variety of formats, for example, in a pie chart depicting the magnitude of the various sources of financing.

Substep 8 - Checks and Reports

In this substep, the program offers a consistency check on the flow of resources across all matrices. Reports allow you to print the estimate table and compile a list of incomplete entries and missing data.
How to Install
National Health Accounts
2.1 Hardware and Software Requirements

In order to use National Health Accounts, the following are required:

- IBM-Compatible personal computer (MS-DOS PC) with 486 or higher microprocessor
- Windows 3.1 or later version
- Approximately 9 megabytes hard disk space (6 megabytes must be available on the drive where your WINDOWS/SYSTEM files are located).
- 8 megabytes of memory (RAM) is recommended
- EGA, VGA, or better display
- Mouse or other pointing device

Use of National Health Accounts without a color display is possible, but a color monitor is recommended, especially for viewing the diagrams and graphs. Printing of National Health Accounts reports, graphs, or diagrams requires that the printer be installed in Microsoft Windows with the appropriate printer driver.

2.2 Installing National Health Accounts

Before You Install National Health Accounts:

In order to install or use National Health Accounts, Windows 3.1 or Windows 95 must be installed and currently running on your computer. Close all open applications—including the software that is “minimized” on the Windows screen.

Using the Installation Routine:

Depending on your Windows version, consult the appropriate section below.

Note:
If you are using an alternative “desktop” for Windows such as one created by Norton Desktop or Navigator, consult that product’s documentation on how to temporarily restore a native Windows desktop. Attempting to install National Health Accounts using the Run command of Norton Desktop will result in an incomplete installation.
2.2.1 Windows 95 Installation

Check the Taskbar to ensure that there are no programs currently running on your machine. If no buttons (other than the Start button) are displayed, you have no main applications running.

The Setup process will check your hard disk to be sure that there is enough space to hold all the required files. It will attempt to place approximately 6 megabytes of files in your WINDOWS\SYSTEM (system) directory. If some of the files are already found in your system directory, then less new disk space will be required.

The Setup process will ask if you wish to name your National Health Accounts folder C:\NHA. If you want to use the default folder, press Enter when this dialog box is displayed. You can install the non-system files to a different folder by changing its name to another drive and/or folder name (for example, D:\NATHLTH).

As the Setup process installs the files, it will prompt you to insert any additional disks.

The Setup program will alert you that National Health Accounts has been correctly installed. You may be asked to reboot your machine.

(Windows 95 users skip the next two sections.) Proceed to Chapter 3.
2.2.2 Windows 3.1 Installation

When you start the installation routine, the only window open on your screen should be the Windows Program Manager screen. This screen shows all the groups of programs you can run on your machine. Do not attempt to run the installation routine using the File Manager.

The Setup process will check your hard disk to be sure that there is enough space to hold all the required files. It will attempt to place approximately 6 megabytes of files in your WINDOWS\SYSTEM (system) directory. If some of the files are already found in your system directory, then less new disk space will be required.

The Setup process will ask if you wish to name your National Health Accounts directory C:\NHA. If you want to use the default directory, press Enter when this dialog box is displayed. You can install the non-system files to a different directory by changing its name here to another drive and/or directory name (for example, D:\NATHLTH).

As the Setup process installs the files, it will prompt you to insert any additional disks.
2.2.3 Manually Changing AUTOEXEC.BAT

You may need to edit your AUTOEXEC.BAT file only if all of the following circumstances apply:

- Your computer is running Windows 3.1,
- Your computer is not running Windows for WorkGroups, and
- You have encountered problems editing your EXAMPLE.NHA file.

The goal of this step is to be sure your AUTOEXEC.BAT routine starts up the DOS SHARE.EXE routine (with the correct parameters). Edit your AUTOEXEC.BAT and be sure that it includes a line reading:

```
C:\DOS\SHARE.EXE /L:500
```

(The C:\DOS\ part may need to be changed if DOS is installed in a different directory on your computer). If this line is not present, or if the /L:500 parameter does not appear, edit this line appropriately and save AUTOEXEC.BAT. You will need to exit Windows and reboot your machine in order to access a fully functional National Health Accounts system.

Using the DOS Editor to Change AUTOEXEC.BAT

To edit AUTOEXEC.BAT, use any text editor. If you are unfamiliar with the text editors available on your machine, leave Windows and bring up the MS-DOS Editor by typing,

```
EDIT C:\AUTOEXEC.BAT
```

from your C:\DOS directory. The MS-DOS Editor will display the contents of your AUTOEXEC.BAT file. Look through the file to see if you already have a line, which invokes SHARE.EXE. If you do, be sure that the line contains the /L:500 parameter as shown on the last page. It may have other parameters, which you should leave unchanged. If it does not have the line, add it. To save your changes, press the Alt key and F and choose Save. Then exit and reboot your system.
How to Use the National Health Accounts Program
Chapter 3

How to Use the National Health Accounts Program

3.1 Starting the Program

Once the installation procedure has been completed successfully, you should see a Program Group for National Health Accounts on your screen in the Program Manager window. It will include two icons: one for National Health Accounts and one for Help. Most of the time you will use the main National Health Accounts program. Help is also accessible from within the National Health Accounts program via the Help menu.

When you start National Health Accounts or when you close your current file, the Welcome to National Health Accounts or initial file selection window is displayed in the center of the National Health Accounts window.

The last project you worked on will be listed as the default choice. To resume work on your last project, all you have to do is press Enter or click on OK to resume work on your project.

The Welcome screen also offers two other choices, Select a different file and Create a new file. The Select a different file option will display the Open Project window, which allows you to select from other projects already on file. The Create a new file option will display the New Project window, where you will define the file name for the project and define the description and additional information about the project.

Note:

When National Health Accounts is started for the first time, two choices are available—to open the Egypt NHA sample project (EXAMPLE.NHA) or to create a new project.
3.2 What is a Project?

When you use National Health Accounts, you will be working on a particular “project.” A project is the largest division of data for the National Health Accounts system. A given project contains a variety of tables, graphics, and other information. Just as a word processing system focuses on a particular document—a letter or an article, for instance—each time you use National Health Accounts, you will select a particular project file to work on.

Each project file is stored in a single file on your disk. It is relatively difficult to move data from one project file to another. Store all your information about a particular analysis in a single project. If you divide your data into different projects you may find it difficult to combine the data later.

By default, all project file names end with the suffix .NHA. Though you can name your project files with any legal MS-DOS name, we recommend you name them with the .NHA suffix, because the system looks for files names with this suffix on disk when you choose the Open command. A typical project file starts at approximately 250,000 bytes (250K) in size.

3.3 Creating a New Project

To create a new project, click on New Project on the File Menu. The system will display a window, which asks for the name you want to call your project on disk. The National Health Accounts system automatically saves much of your data when operating the program, so it needs to know where you are going to store that data on disk.

By default, the system expects to save your data in your NHA directory, though you can save it elsewhere. To save your data to a file called NEWPROJ.NHA, type NEWPROJ.NHA in the File Name field.
Once you have chosen the disk, directory, and name for your new project, click on OK.

3.4 The Country Profile Screen

After you have created a new National Health Accounts project and chosen a name for the new project file, the program will display the Country Profile screen. Use this screen to enter general information about the country being analyzed, such as the unit of currency, model and base years, and other values that apply to your entire project.

The values entered on this screen will be used in the Estimate Table, Graph, and Reports windows to perform currency and per capita calculations. When the Country Profile screen is first displayed, an asterisk (*) will appear in each of the value fields to indicate that no value has been set. Until you enter this data, many of the conversion
options allowed on the Estimate Table, Graph, and Reports screens will be unavailable to you. See section, 4.3, “Choose Value to Display” for more information.

If you wish to enter this data after you have moved on to other steps of the project, you can access the Country Profile screen from a button at the top of the Step by Step Menu window, or via the Country Profile menu option on the File menu.

For documentation purposes you can enter the Country Name, Currency Unit Name, and Model and Base Year fields. The Model Year is the period for which you are doing the current NHA analysis. The Base Year is a year you select for comparing the current analysis against some different period, or standardized numbers from other countries. It can be a year either before or after the Model Year. These fields will help you identify this analysis at a later time. Values entered in these fields are not used in any calculations.

At the bottom of the window is a set of radio (option) buttons titled “Values entered are in.” Select one of the four choices. If you select “Millions (000 000),” all the values entered for flow will be interpreted as being in millions of your national currency units.

For example, if the Currency Unit is rubles, and the Model Year is 1995, and the Millions button is selected, a flow value of 56.6 will be interpreted as meaning “56,600,000 Rubles in 1995.”

You can also input the national population values for the model and base years. The “Values entered are in” choice and population values are utilized in the per capita calculations.

National Health Accounts provides you the option of recalculating the values in the NHA matrix in U.S. dollars and Purchasing Power Parity dollars for the year of your NHA estimate. You can also recalculate values in the matrix in terms of a “real” or base year value, for comparison purposes.

PPP dollars are estimated corrected for purchasing power differences between countries. One PPP dollar has approximately the same purchasing power in terms of a basket of real goods in different countries. For further information about the definition and construction of PPP values, see Salvatore, 1993, and Salazar-Carrillo and Prasada Rao, 1988.

Real or base year estimates recalculate the matrix cells in terms of their estimated equivalent quantities in a previous year, that is, corrected for inflation. Real value estimates can be obtained in national currency, U.S. dollars, or PPP dollars.

The Country Profile screen lets you input the appropriate coefficients for making these different calculations. You must determine the coefficients yourself, from available statistical data in your country or from international sources. Exchange rates for the year of your NHA estimate can usually be obtained from the central bank, ministry of finance, or a national economics or statistics reference. They can also be obtained from the World Bank or in editions of the World Development
Report or World Economic Statistics. PPP dollar rates may also be available from these sources or from International Financial Statistics, published by the International Monetary Fund.

In order to use all the currency calculation options you must provide the following data:

For the Model Year:

- U.S. dollar exchange rate in the model year, entered in the form of: National currency/US $1
- PPP dollar exchange rate in the model year, entered in the form of: National currency/PPP$1

For the Real Value calculations:

Adjustment coefficients for estimating base year values are entered as index numbers, with the base year = 1. For example, if there was 70 percent inflation in the national currency between the base year (=1) and the year of the NHA model, the adjustment coefficient for national currency would be 1.7. The program calculates real values as follows: first the real (i.e., base year) value of the model year national currency value is calculated. This gives the national currency base year figure. Then, to obtain the U.S. dollar or the PPP dollar figure, the national currency base year figure is divided by the U.S. dollar or PPP dollar exchange rate for the base year. For real value calculations you must enter the following:

- National currency adjustment coefficient (as above)
- U.S. dollar exchange rate in the base year, entered in the form of: National currency/US $1
- PPP dollar exchange rate in the base year, entered in the form of: National currency/PPP$1

For more information, see the currency and per capita calculation choices in the Choose Value to Display window in section 4.3.

### 3.5 The Step by Step Menu

When you start a new project or select a pre-existing one, the Step by Step screen is displayed. It also is shown whenever a project is open and no other main window is displayed.

The National Health Accounts methodology, each matrix, and the substeps of each matrix will be discussed in detail in Chapters 4 and 5.
3.6 Opening a Project File

There are three ways to start an existing project:

Select one listed directly on the File menu,

Choose Open on the File menu and see the files that exist on your disk, or

Select the Last File or Select a different file options on the Welcome screen (see above).

3.6.1 The Last Accessed List on the File Menu

National Health Accounts records the last four projects on which you have worked. These four projects are listed at the bottom of the File Menu. To start one of your existing projects, click on its file name as listed on the File Menu.

3.6.2 Finding a Project on Disk

Click on the File Menu option and select Open. The system will display a window showing all the project files in your current National Health Accounts (NHA) directory. To select one, click on its name and click on the OK button.

To look in another directory, click on the directory's name. Once its contents are listed, you can select an .NHA file to open by clicking on its name then click on the OK button.
3.7 The Sample Project: The Egyptian Health Care System

This manual uses a sample National Health Accounts project, the Egyptian Health Care System, to illustrate procedures described in the text. This file, EGYPT.NHA, is shipped as part of the installation. It has been included in the NHA software as an illustrative example of how to apply National Health Accounts, and selected windows are displayed in this manual. These figures are more fully discussed in the 1995 report, National Health Accounts of Egypt by the Department of Planning of the Ministry of Health and the DDM Project.

3.8 Saving Data

3.8.1 Automatic Saving

National Health Accounts saves most of your data when you click on the OK, Add, or Remove button on any screen. When you open a detail window, either to add a row or edit one, the system will save your data as soon as you click on the OK button. Clicking on Cancel will stop the data from being saved to disk.

3.8.2 Save As

National Health Accounts also supports the Save As function. Save As allows you to make a copy of your current project (.NHA file) and continue work on that copy. For instance, if you want to save your work in the current file and create an extension of your work in a different file, click on Save As on the File Menu. The system will ask you for the name of the new file to create. Once you have provided the name and location of the new file, National Health Accounts will copy the file to the new name. It will also close the old file. All additional work will be on the new file until you use the Close Project or Open Project functions.

If you want to copy a table's data to a file—for possible use in a word processor or spreadsheet program—see the Export function described in section 6.2.


3.9 Closing a Project File

When you Open a project or initiate the New Project process, any project you currently have open is automatically closed. Projects are also automatically closed when a project file is compacted or repaired or when you leave the system. See “Database Compacting and Repair” in section 7.2 for further information on these features.

You can close your current project at any time by clicking on the Close Project option on the File Menu. Once you close your project, the Welcome to National Health Accounts screen will be displayed.

3.10 Leaving the Program

To shut down National Health Accounts, take any of the following actions:

- Double click on the Control-menu box—the square in the upper left corner of the National Health Accounts window that looks like a minus (−) sign enclosed in a box. (In Windows 95, single click on the X button in the upper right corner).
- From the File Menu, select Exit.
- From the Welcome to National Health Accounts screen, click on the Exit button.
- Close down Windows itself. (This will close down all windows programs that are running. Never close Windows when National Health Accounts is performing an action.)

You should back up your project (.NHA) files frequently; when you leave the National Health Accounts program is a good time to do so.

3.11 Help

To access help, do any of the following actions:

- Click on the Help button on the Welcome to National Health Accounts screen,
- Select the Contents option on the Help Menu, or
- Click on the Help button located in the lower left on many windows.
How to Use the Basic Elements of National Health Accounts
4.1 Main Windows

National Health Accounts has four predefined matrices accessible from the Step by Step window. The program also allows you to create additional matrices using the Other Matrices feature. The five main buttons on the Step by Step screen correspond to the five matrices.

<table>
<thead>
<tr>
<th>Five Matrices</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Sources to Financing Agents</td>
</tr>
<tr>
<td>2. Financing Agents to Providers</td>
</tr>
<tr>
<td>3. Financing Agents to Functions</td>
</tr>
<tr>
<td>4. Financing Agents to Line Items</td>
</tr>
<tr>
<td>5. Other Matrices</td>
</tr>
</tbody>
</table>

Once you have entered one matrix by clicking on the corresponding button, the Matrix Steps window will be displayed for that matrix. The other matrices will be displayed as file tabs. The user can switch between matrices by clicking on the tabs.

On the Matrix Steps screen, each matrix has a series of substeps associated with it. For example, if you press the first button, Sources to Financing Agents, a series of substep buttons are displayed that guide you through the construction of the Sources to Financing Agents estimate matrix and associated tasks.
The structure of the series of substeps is identical for each matrix and follows this order:

1. Choose Entities
2. Define Flow
3. Detailed Flow Diagram
4. Full Flow Diagram
5. Estimate Matrix
6. Graphs
7. Matrix Bar Graph
8. Checks and Reports

When you click on one of these buttons, the window associated with the function will appear on top of your main National Health Accounts window.

Once you have entered a particular substep, you can move back and forth between substeps by clicking on the Next and Previous step buttons at the bottom of the respective window. There is no need to exit out to the initial substep list again.

If you wish to change the order of the steps, you can do so via the Settings window. See section 7.1 for more information on the Settings window.
4.2 A Tour through the NHA Methodology

This section of the manual will take you on a brief tour through the substeps of the program, using the first matrix, Sources to Financing Agents, as an illustrative example.

The completion of the Sources to Financing Agents analysis is a prerequisite to the remainder of the matrices, which rely on the allocations the analyst has made to the financing agents in this first matrix. As was mentioned in Chapter 1, the funds mobilized in the health sector do not pass directly from the primary sources to their final uses. Instead, much of the money first passes through financial intermediaries, known as financing agents in the NHA software, which in turn transfer resources to the ultimate providers of care. This intermediate category of payer allows for the separation of financing and provision of health care services. In some cases, however, sources and financing agents may be identical. This would be true in the case of households and firms that pass much, if not most, of their expenditures directly to the ultimate providers of care. In these cases, households and firms appear as “virtual” financing agents in the NHA analysis—not formally constituted as a financing agent but still representing a funding pass-through.

For all sources of funding, money is transferred to more than one financial intermediary and provider. These interrelationships are easily visualized through the flow of funds diagram that is constructed in substeps 2 through 4 on the following pages.
4.2.1 Substep 1: Choose Entity Agents

You use the Choose Entities window to define the source and destination entities for a given matrix. In the Sources to Financing Agents matrix, you must first define the sources and the financing agents. To enumerate sources, you can choose from the list of sources built into the program or add your own source categories. Your choices then appear on the Sources list that appears on the right side of the window.

To add a source from the list of choices preloaded with the software, click on the item you wish to add in the Sources list box. Then, click on the Add button above the list box. To add an entry not on the list, enter the entity name in the edit box and click on the Add button above the edit box.

When adding your own source category or editing a source entity already listed by clicking on the Edit Entities button, the Edit Entity window will come up. The Edit Entity window allows you to choose an abbreviation for the entity, enter its total amount as a source, and designate the sector (government, public sector, or private sector) of the entity. The abbreviation is used in the graphs and diagrams to represent the entity. It is best to enter a recognizable abbreviation for the entity. The categories government and public sector are not mutually exclusive, so the user should refer to the definitions in the glossary (see “public expenditure on health”).

Choose the entities for financing agents in the same manner.
The panel also allows you to designate a “custom order” value for this entity. You can use the Entity Order option in the Settings box to cause many of the lists and displays in National Health Accounts to display in the order you designate. This is discussed further in the section on “Settings” in section 7.1.

The Entity Total Amount field can be used to validate the total flows entered. Later in the process (substep 5), you can use the Details for: (Entity) window accessible from the Estimate Matrix window to compare a sum of the flows to or from this entity with the Entity Total you enter here. Use the Inconsistent Values Report (in substep 8, Checks and Reports) to do a global comparison of all flows with totals entered on this window.

In the Egypt example, sources included all those listed in the default listing plus private insurers and a social insurance agency. In addition, the default listings were modified to correspond to the source terminology as used in Egypt.
4.2.2 Substep 2: Define Flow

In this substep, you can trace the flow of resources from a single source to various financing agents. You can choose multiple financing agents from the list of financing agents that you identified in the Choose Entities screen. The screen also allows you to remove financing agents entered by mistake.

You must fill out a separate screen for each source. You can switch between the sources by clicking on the Previous or Next buttons, located on either side of the Add Entities button.

If you have not filled out the Choose Entities form, you can return to it by clicking on the Add Entities button. Return to the Choose Entities window if you need to add an additional source or financing agent.
4.2.3 Substep 3: Detail Flow Diagram

This screen graphically displays the information you entered in substep 2. As in substep 2, you can move between each source entity by clicking on the Previous Entity or Next Entity buttons at the bottom of the screen.

If you wish to add more flows from a single entity directly, click on the Add Flows button located in the lower right corner of the screen. The program will prompt you to click on the “from” (top) entity to select the source of the flow. In the case of the Egypt example, if we had forgotten to show the flow of funds between foreign aid and the Ministry of Health, we could add the flow as described above.

Then the program will prompt you to click on the entity the flow is “to.” The program then automatically draws a line representing flow of funds from the source entity to the financing agent entity selected. Once you are done adding flows, click on the Stop Adding Flows button in the lower right corner of the screen.

The Add Flows screen also allows you to remove flows if you have made a mistake or wish to view the graphic and matrix without this particular flow. Click on the Delete Flows button located in the bottom right of the graphic display.

Later, when you have entered data for the other matrices, you can use the Detailed Flow Diagram window to view the flows from two linked matrices via the Show 2 Matrices button. For example, you could view the flows from sources through financing agents to providers.
4.2.4 Substep 4: Full Flow Diagram

Substep 4: Full Flow Diagram
Displays the flow between entities by selecting who receives resources from whom

This step graphically summarizes the flow of funds detail entered in substep 3. All sources are shown with their links to the financing agents. The program allows you to add additional flows using the Add Flows button or remove flows using the Delete Flows button, using the same procedure described in substep 3.

The buttons Previous Matrix and Next Matrix allow you to go back and forth between the various matrices you have constructed.

You can switch between the Full and Detailed Flow by clicking on the Detail Diagram button. This may help you disentangle the flows if there are many entities and many flows defined. See substep 3 for information on the Show 2 Matrices feature.
The estimate matrix is the heart of the NHA methodology. The first two predefined matrices, Sources to Financing Agents and Financing Agents to Providers, comprise the full “sources to uses” matrix that make the NHA methodology most useful to policymakers.

The estimate matrix that shows expenditure flows from sources to financing agents is two-dimensional. On the horizontal axis, all ultimate sources of financing appear. These sources are drawn from the information input during substep 1. On the vertical axis, all financing agents are listed. All expenditures estimated by the different sources must be allocated to specific financing agents, since the totals and subtotals must add up and be consistent.

The estimate matrix can also display values that are the result of a series of calculations. Calculations include currency conversions, adjustments for inflation, percent values, and per capita values. Click on the Choose Values to Display button to apply these calculations. See the topics in the “Choose Values to Display” section, below, and “The Country Profile” section in Chapter 3.

To enter data into a cell, simply double-click on the cell or select the cell and click on the Flow Detail (Cell) button. The Flow Detail pop-up will appear. The Flow Detail screen traces the flow of resources from a particular source to a particular financing agent, for example, from households to private insurance (see further discussion and image, below).

If you wish to enter all estimates at once without filling in all the information in the Flow Detail pane, click on the Quick Entry button in the center of the window. The Matrix Quick Entry pane functions like a
spreadsheets. Data can be entered by positioning the cursor in each cell and typing in the values. Click on OK when you are finished entering the data. If you do not click on OK, the information will not be saved.

For those using the program to gain a better understanding of how NHA works, it is best to go through the Flow Detail screens for each flow rather than going directly to Quick Entry. The Flow Detail screen allows the analyst to document the information sources that fed into the estimate and associate a scale of reliability with that estimate. The list of information sources, their reliability, and any comments you may have made can be printed from substep 8, Checks and Reports. The reliability scale weights an estimate according to whether the quality of the estimate corresponds to the quality you might expect from audited accounts or whether the estimate is acceptable or unacceptable (see glossary for more detail).

In addition, the screen shows the breakdown of total source spending through the display of the other defined cells. The analyst should also note if the flow demands further research by clicking in the small white box, Needs further research. You can move among cells by either clicking on each new cell directly or clicking on the Previous and Next buttons at the bottom center of the Flow Detail screen.

If you wish to add additional entities from the Estimate Matrix screen, simply click on the Add Entities button in the upper left corner of the pop-up to return to the Choose Entities screen (substep 1). If you wish to define additional flows of funds, click on the Define Flow button to return to the Trace the Flow screen (substep 2).

You may have a long list of sources and all the columns may not be displayed on your monitor at the same time. If this is the case, you can scroll left and right by clicking on the arrows at either end of the column series.

NOTE:

In substep 1, Choose Entities, you designated a total amount to each source. In this substep, you are allocating this total source amount amongst the various financing agents. Theoretically, the amounts allocated among the financing agents should sum to the total amount listed for each source. However, because NHA estimates can be calculated in different ways, the program allows for discrepancies between the totals and the summed allocated amounts attributable to a particular source. For example, total household spending on health care services could be estimated either from the revenues of health care providers or from surveys of households themselves. Data on pharmacy sales and user fees at government and public facilities may also feed into the construction of NHA estimates of household spending. The analyst will select an information source, or a combination of information sources, depending on the sources' perceived reliability. If there is a discrepancy, this will be reported in the Consistency Check report described in substep 8, Checks and Reports. The analyst can then decide how to adjust the estimate such that it balances with the remainder of the prepared estimates, either through modifying the reported total (from the Choose Entities window) or tolerating a certain degree of inconsistency.
To compare the program-generated total of flows for a given item with the single value you may have entered in the Add Entity or Edit Entity windows, double click on the total highlighted (in yellow on the screen) for an entity. The Details for: (Entity) window will be displayed.

This window compares the single value associated with an entity with the total of all flows to and from that entity. The Amount on File value is the value entered on the Edit Entity window. The Table Total is the total you clicked on to reach this window from the Estimate Matrix window. The bar at the bottom of the window compares the two values, showing (up to 100 percent) the percent value that the Estimate Matrix total value makes up of the Edit Entity value.
4.2.6 Substep 6: Graphs

The Graph button on the substep menu will display the matrix estimates in a graph. The program will display nothing here if there are no estimates entered in the estimate matrix in substep 5. The first graph will plot the expenditure estimates of all of the sources for whom you have entered data.

If you click on the Other Axis button in the center of the button bar under the Graph pop-up, the program will show you the matrix estimates for each of the financing agents for whom you have entered data.

This same information can also be displayed in the form of a pie chart by clicking on the Pie button.

The Graph can also display values that are the result of a series of calculations. Calculations include currency conversions, adjustments for inflation, percent values, and per capita values. Click on the Choose Values to Display button to apply these calculations. See the Choose Values to Display window (section 4.3) and the Country Profile window (section 3.4.)
4.2.7 Substep 7: Matrix Bar Graph

In this substep, Matrix Bar Graph, the program displays the data you entered in substep 5, Estimate Matrix, in horizontal bars that represent the relative share of expenditures that are disbursed and received.
4.2.8 Substep 8: Checks and Reports

The purpose of the Checks and Reports window is to allow you to review and analyze the data you have entered earlier in the process. The window is divided into three areas: Checks, Reports, and Export Data.

The checks section of the Checks and Reports screen allows you to run a consistency check within your current matrix or across all the matrices for which you have data. The check produces an Inconsistent Values Report that can be printed or exported to another application.

The consistency check verifies that all the data entered sums by row and column. Running the check compares the totals in your current matrix to the totals you entered in the Edit Entities window. Running the check across all completed matrices compares totals in the current matrix to the totals in all other matrices and the totals entered in the Edit Entities window. The check will report discrepancies within a given tolerance interval which the user can modify depending on their data. The default value for the tolerance interval is 50 percent. This means that the program will search for any estimates that are over 50 percent greater or smaller than the comparable estimate. This flexibility allows the user to include estimates that are not consistent with one another within a certain range, but it also highlights problematic estimates. Ultimately, the analyst will want to reconcile these estimates. In that case, the analyst should have zero tolerance for discrepancies and fill in a “zero” in the tolerance interval blank.

The Reports section, the middle section of the Checks and Reports screen, allows you to print any of the estimate matrices for which you have data. The Estimate Table Report will show data for up to six of the “from” entities for the matrix and all the “to” entities. First, you must
select the Estimate Table (Grid) Report for a matrix from the Report list by clicking on it once. Second, you should select the particular matrix you wish to view from the Matrices Covered by Report list. Click on Run Report button to display the Select Columns for Report window. You can choose the specific “from” entities (up to six), or select a group comprising the first six, second six, and so on via the Choose a set of six columns option.

The Estimate Table report can also print values that are the result of a series of calculations. Calculations include currency conversions, adjustments for inflation, percent values, and per capita values. Click on the Choose Values to Display button to apply these calculations. See the topics on Choose Values to Display window (section 4.3) and Country Profile window (section 4.3).
The Reports section also allows you to run a report on any incomplete entries that might be left in your estimate matrix. Click on the Incomplete Entries in Matrix Report under the Report list and then click on the Run Report button. After you have clicked on Run Report, a pop-up will appear that will prompt you to define the selection criteria for the report. This screen will select only those cells that meet the criteria you have selected.

A third report, the Flow Detail Report, presents a complete listing of all the flows in the selected matrix. You can use this report to review all the data you have entered into the program.

The Checks and Reports screen also allows you to export data to spreadsheet programs. More information on this function can be found in Chapter 6. Information on using the Reports window also is discussed in Chapter 6.

4.3 The Choose Value to Display window

On the Estimates Table and Graph windows and for certain reports, National Health Accounts allows you to display your values adjusted on the basis of per capita, inflation, and comparative value calculations. Where this feature is offered you will see a button titled Choose Value to Display. When you click on this button the Choose Value window will be displayed.

The choice you make on the Choose Value to Display window applies only to the current session or printed report—it does not change any of the values stored in your model. Your choice on this screen will be displayed in the legend on the screen or report and will remain in effect for all applicable windows until you close the project or program or change the setting.
Calculations are based on values entered in the Country Profile screen. If necessary coefficients are not yet provided, the choices will not be available and the buttons will be disabled on the Choose Values screen. You can access the Country Profile screen from the Step by Step Menu screen or via the Country Profile option on the File Menu. See section 3.4, “The Country Profile Screen” for more information.

Based on the input in the Country Profile screen, you can obtain the following recalculated values for the NHA matrix.

- **US$ for the estimate year = national currency in estimate year/US$ exchange rate in the estimate year**
- **PPP$ for the estimate year = national currency in the estimate year/PPP$ exchange rate in the estimate year**
- **National currency quantities for the base year = national currency in the estimate year/Index number relative to the base year national currency value**
- **US$ quantities for the base year = national currency estimate for the Base Year/US$ exchange rate for the Base Year**
- **PPP$ quantities for the base year = national currency estimate for the Base Year/PPP$ exchange rate for the Base Year**

Many of these values can also be calculated on a per capita basis (if you have entered the necessary population values for model and base years on the Country Profile screen). The per capita calculations also involve the units multiplier, so make sure that the values per cápita are in the correct value units.

**Example: Per capita Calculations**

Here is an example of a per capita calculation based on the current US$ index value.

For the following information:
- A flow value of 47510 (a cell in the Estimates Table)
- Values in thousands (000s) (Value units entered on the Country Profile screen)
- US$ exchange rate of 1.5 (entered for the project on the Country Profile screen)
- Current year population of 26,000,000 (on the Country Profile screen),

this calculation would be performed:

\[
\text{Displayed value} = \frac{(47510 \times 1000)}{1.5}/26,000,000
\]

That is, in the current year, approximately $1.22 per capita was spent on health care.

Values can also be displayed in terms of the percentage they make up of the row or column they are in, or the total of all cells. Percent of values cannot be displayed in per capita terms. When a Percent of option is selected, the row and column totals display the values, not percent values.
4.4 Other Helpful Information

There are several buttons that appear on many NHA screens. They include:

**Help:** Displays help text for National Health Accounts. This button is located in the bottom right corner of every substep screen in the program. The help text is based on this manual.

**Add:** Initiates the addition of a row to one of the main tables. This button is enabled only on the Choose Entities and Define Flows screens.

**Remove:** Removes entities from lists in the Choose Entities, Define Flows, and/or Estimate Matrix screens. If the item to be removed includes a substantial amount of data, you will be prompted to confirm the deletion.

**Print matrix or graphic:** For graphs, a window is displayed providing a variety of options (see “Printing Graphs” in Chapter 6). For matrix diagrams, the print window invokes a screen print to your default Windows printer.

**Close:** Close the current main window. When all the main windows are closed, the Step by Step screen will be displayed.

4.5 Other Windows

In addition to each substep window, there are a variety of other windows. They include windows associated with the Tools menu option and printing, saving, and exporting data (see Chapters 6 and 7).

In some cases, the system may ask you a question or deliver a short message in a small window. Message windows are used throughout National Health Accounts to alert you to errors or to request confirmation for an action that has significant consequences. Simple messages have only an OK button, whereas confirmations have OK or Cancel. In most cases, Cancel will return the system to the state it was prior to initiating the action.

See also section 7.1, “Settings.” The Settings window allows you to make certain choices that affect all analyses you perform with National Health Accounts.
How to Use the Other Matrices of National Health Accounts
How to Use Other Matrices of National Health Accounts

In addition to the Sources to Financing Agents matrix, the NHA methodology comprises three other predefined matrices. From the financing agents, funds can be allocated in a variety of ways (or "uses"), depending on available information.

5.1 Matrix II: Financing Agents to Providers

The Financing Agents to Providers matrix is the most common "uses" breakdown of NHA used in developing countries to date. Combined with the Sources to Financing Agents matrix, it produces a complete picture of a national health care financing system. Estimates on the allocation of funds from financing agents to providers are reasonably easy to determine from government budgets, household surveys, and other administrative records. Quality may vary from country to country, but, in most cases, reasonable estimates can be generated.

The substeps associated with the Financing Agents to Providers matrix are identical to those associated with Sources to Financing Agents, with the exception that the entities to be used as "providers" must be defined. A list of possible providers is provided in the section “The Eight Substeps of the NHA Analysis,” in Chapter 1.

5.2 Matrix III: Financing Agents to Functions

Allocating funds in the matrix Financing Agents to Functions is a greater challenge for the analyst, but it can be extremely useful for policymakers. Functions may include inpatient and outpatient treatment of illness, personal preventive care, and/or population-based public health functions.

A sub-analysis might trace the sector financing of particular functions of interest, such as family planning or maternal and child health. These data are sometimes difficult to collect; even where possible to collect them, it may be difficult to ensure consistency between estimates generated in other matrices and those allocated to a particular function. For example, one might rely on previously conducted studies of time use in facilities that jointly supply family planning and maternal and child health programs to estimate the relative share of expenditure associated with each program.
Further, demand-side estimates of these expenditures, for example, from household surveys, are unlikely to be consistent with these supply-side estimates. The substeps are identical to those of other matrices.

5.3 Matrix IV: Financing Agents to Line Items

Line items such as salaries, drugs, equipment, and/or capital investment represent another potential “uses” analysis within the NHA framework. Within ministries of health, expenditures by line item may be relatively straightforward to assess. However, this information is difficult to collect in the private sector and may require a special study. The substeps in these windows are identical to other matrices.

5.4 Matrix V: Other Matrices

An NHA analysis can incorporate a number of other matrices, such as Financing Agents to Regions, Financing Agents to Age Groups, or other measures of the equity of financing distribution. The software allows you to include matrices relevant to the policy situation.

In order to add a matrix, click on the Other Matrices tab at the top right corner of the Matrix Steps screen. An empty table will appear. Click on the Select Matrix button in the top right corner of the tab screen. The program prompts you to choose a matrix, by clicking on one of the matrices listed, or, to add a new matrix, by clicking on the New Matrix button. If you wish to deselect a matrix, click on the Unselect button.

If you decide to add a matrix, the Add Matrix window will prompt you for the matrix name and the “from” and “to” axes. The window asks that you enter the plural form (for example, Regions) and the singular form (Region) of the word for entities on that axis. When you are done, click on OK. If you decide to exit, click on Cancel.

Once you have determined which matrix you will construct, the substeps are identical to those outlined in section 4.2, “A Tour through the NHA Methodology.”
How to Print and Export Information
6.1 Printing

National Health Accounts allows you to print out a set of reports for the data that you have entered. The print function can be accessed directly from the various substep windows or from the Reports screen (substep 8) by clicking on the Print icon. Reports that are available to print are listed in their entirety in the Matrix to be Covered by Report list in the Checks and Reports screen. All graphics can be printed directly from the screen.

6.1.1 To access the printing options

To print the currently displayed main window, click on the Print button at the bottom of each screen or select Print from the Main Toolbar. A graph must be the currently displayed in the main window in order to be printed.

6.1.2 Report Print Preview window

Once you click on the OK button on the Printing window, the system will display the Report Print Preview window. This window allows you to browse your report before you print it. To print the report from the Report Print Preview window, click on the Print button.

Note:
The current version of the National Health Accounts does not allow the printing of all data. If necessary, you may be able to use the Copy and Paste commands to transfer this data (via the Windows Clipboard) to a word processing program or to the Microsoft Windows Paint and Paintbrush accessories.
When the Report Print Preview window is displayed, no option other than Help can be accessed. To return to the Main Menu and to enable other options, close the Report Print Preview window by clicking on the Close Report Print Preview button on the toolbar.

(As for most windows, clicking on the Maximize button—the up arrow in the upper right corner of the window—will cause the window to expand to fill the display. To close any window, click twice on the Control-menu Box—the square in the upper left corner of the window which looks like a minus [−] sign enclosed in a box.)

6.1.3 Report Print Preview toolbar

The buttons on the Report Print Preview toolbar allow you to:

- Move forward and backward in the display of the report
- Halt execution of report generation
- Zoom in and out on the view of the report
- Export in a variety of popular formats
- Print the report
- In some cases, export the report to electronic mail

(Numeric values between the Next and Previous buttons indicate which page is being displayed in the window. The numeric values at the far right indicate the number of records covered by the report).

Moving forward and backward in the display (if the report is a single-page report, these buttons will not be active):

- **First Page**: Move to the first page of the report.
- **Previous Page**: Move to the previous page of the report.
- **Next Page**: Move to the next page of the report.
- **Last Page**: Move to the last page of the report.
- **Cancel**: Cancel Execution: If the system is still building the report, clicking once on this button will halt further construction of the report. The portion of the report which has already been built will be displayed.

- **Zoom**: Zoom/Full-Page: Clicking on this button will cause the preview display to toggle between different levels of resolution of display.
Destination Options:

**Print**: Print the report.

**Export to Electronic Mail**: Due to the variation in electronic mail systems, this button is not automatically enabled during installation. If enabled, depending on the nature of your electronic mail system and/or internal network, this button may allow you to send your reports to others via electronic mail.

### 6.1.4 Printing Graphs

Graphs can be printed to one of four destinations:

**Printer**: The Printer option will print a graphical representation of what is displayed on the screen, minus the toolbar and menus.

**Bitmap file**: This option will create a windows .BMP file containing the screen image. When you choose the Bitmap option, the system will ask you for the name of a file to store the data on disk. Many Windows word processors will allow you to include the .BMP file as a picture in documents. Graphical programs such as Microsoft Paintbrush can be used to edit or change the image.

**Windows Metafiles**: This option will create a .WMF file containing the screen image. When you choose the Windows Metafile option, the system will ask you for the name of a file to store the data on disk. Some products such as Powerpoint will allow you to include the .WMF file as a picture in documents. WMF files are more compact and faster for programs to draw than Bitmap files.

**Clipboard**: Using the Clipboard option will place a copy of the image in memory. Most other Windows applications that support images can then be used to Paste the image directly into documents or other pictures.

For all destinations, if scroll bars are shown on the graph, there are more entities than can be printed on a single image. In this case, after printing the first image, scroll down and print for any additional entities.

### 6.1.6 Printing Matrix Diagrams

The Diagram Print Preview window is divided into a large view area at the top of the window and a variety of controls governing your printing choices at the bottom of the window. The view area shows a portion of what will be printed.

In the lower left of the Diagram Print Preview window are two sets of radio buttons and an Options button:

**No Color/Monochrome/Color**: governs the color and format of the printed output. Choose one of these options. No Color will produce a line drawing, without any color filling. If your printer is an older printer with less memory, you may be able to use this option if the others do not operate with your printer. Monochrome
Diagram Print Preview Window

Diagrams will draw a grayscale image with colors from black to white. Color will allow printing of the diagram on color printers.

Landscape/Portrait: determines whether the view will be longer than it is tall (landscape) or taller than it is long (portrait).

Immediately to the right of the radio button options is an inset panel governing the view displayed above in the view area. You can use the Zoom buttons to scale your view to some percentage of the actual size. Zoom settings will not affect the actual printing of the diagram. They will only affect your preview of it. You can also zoom in closer by double-clicking on a portion of the image in the view area itself. If there is more than one page in the output, you can use the Page buttons to toggle between the pages. The Page buttons are shown (when applicable) to the right of the zoom buttons.

The Choose Printer button will access a small window used to select the printer. To select a printer other than the one in the Current Printer box, click on a printer in the list. It will become the current (or default) printer when you click on OK to close the window.

Warning:

This will set the default printer for all active Windows applications.
When you click the Print button, the pages listed in the “Print page…through page...” area will print. For example, to print pages 2 through 4, type “2” in the first box and “4” in the second. To print a single page, fill in that page number in both boxes. For single page output, both boxes will be prefilled with “1.”

The diagram printed may span many pages. The number of pages will be determined by the maximum number of entities in the matrices covered in the diagram. The pages have been designed to overlap to facilitate the production of a large poster-sized diagram.

6.2 Exporting Report Data

Report data can be exported in the Export Data section of substep 8, Checks and Reports. This function automatically exports all matrices in a project to a spreadsheet program in a Comma-Separated Value format. Click on the Export Data button and save your matrices as you would any other document in a Windows program. When you open the file in a spreadsheet package, some formatting changes, such as the sizing of columns and rows, may be needed.
How to Use
National Health Accounts Tools
7.1 Settings

The Settings window allows you to make certain choices that affect all analyses you perform with National Health Accounts. To access the window, choose Settings under the File menu.

One major function of this window is to allow you to reorder and/or rename the NHA substep buttons on each matrix screen. The default settings correspond to the substep order structure described in previous chapters.

The Settings screen also allows you to erase the record of completed steps that is recorded in the small white check boxes to the left of each substep and in the Progress Checklist.

The Entity Sort Order setting determines the order in which entities will be displayed on a variety of the main windows in the system. The Custom sort order selection will cause the entities to be displayed based on a code you enter for each entity. See the Edit Entity window, discussed in Chapter 4.
Matrix Image (Diagram) Max. Width box can be used to adjust the maximum width in pixels of the Matrix Diagrams drawn by the software. Adjust this setting lower if the software does not draw Matrix Diagrams properly. The maximum setting that will operate on a given machine is roughly tied to available system memory.

7.2 Database Compacting and Repair

7.2.1 Compacting Projects

National Health Accounts project files (.NHA files) can grow to considerable size. In certain circumstances, such as when numerous items are deleted after being added, the .NHA file can become larger than necessary. To reclaim space used by the file, you can compact the file via the Compact Project option on the Tool menu.

When you select this option, the system will first check to see if it has enough temporary space on disk to perform the operation. There must be at least as much extra space on disk as the size of the file. Thus, if your NHA file is 360K in size, you must have 360K free space on disk to compact the file. Compacting the file involves making a temporary copy of the file.

Once the checks are complete, the project will be closed and the process will commence. Once it has finished, a message box will announce the completion. To continue work on the project, open the project.

7.2.2 Repairing Projects

Avoid rebooting or turning your machine off while National Health Accounts is running. Sometimes, doing this will cause no damage to the National Health Accounts project file (.NHA file). In other cases, subsequent attempts to open the project file will result in a message warning that the file is “not a National Health Accounts” file or “may be corrupted.” If this happens, you can use the Repair Project option to attempt to recover your data.

To initiate the repair process, click on the Repair Project option on the Tools menu. If Repair Project is done while a project is open, the current project will be closed and repaired after you click on OK on the confirmation message box. When Repair Project is invoked and no project is open, a window similar to the Open Project window is displayed. Select your damaged file via this window and click on OK.

Repair Project also compacts the project after the repair step is complete. You must have at least as much free space on the disk where the NHA directory is located as the size of the file to be repaired.

The Repair Database function cannot solve all possible losses of data, so back up your project (.NHA) files frequently.
Glossary

**Audited Accounts**: estimates that are drawn from professionally audited accounts.

**Acceptable Estimates**: estimates that are based on reliable data sources, subjective according to the data situation of each country.

**Entity**: an organization, group, or type of use of funds.

**Financing Agents**: entities which pay for or purchase health care services; may own and operate provider institutions or may finance services provided by others; receive funds from sources and pay them to providers.

**Flow**: an avenue of expenditure between a source and a financing agent, or a financing agent and a use.

**Public Expenditure on Health**: central government expenditures through the ministries of health and transfers to other governmental public health institutions that operate with their own budgets; health expenditure by decentralized levels of government; health expenditures by social security systems or publicly funded social services programs (such as those associated with the military).

**Private Expenditure on Health**: direct out-of-pocket spending by households to pay for general and specialized medical services, drugs, lab exams, prostheses, eyeglasses, hearing aids, and other durable medical equipment; and clinical services and hospitalization; spending by firms of health insurance premium or other expenditure on clinical services and hospitalization.

**Providers**: a type of “use” category referring to those entities that are direct providers of medical care services.

**Sources**: entities who provide funds to financing agents, who are direct purchasers of or payers for health care.

**Unacceptable Estimates**: estimates that are based on poor quality data sources, estimates in which you have no confidence.
### Acronyms

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Full Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDM</td>
<td>Data for Decision Making</td>
</tr>
<tr>
<td>DOH</td>
<td>Department of health</td>
</tr>
<tr>
<td>GDP</td>
<td>Gross domestic product</td>
</tr>
<tr>
<td>HCFA</td>
<td>Health Care Financing Administration</td>
</tr>
<tr>
<td>LAC</td>
<td>Latin America and Caribbean</td>
</tr>
<tr>
<td>MOH</td>
<td>Ministry of health</td>
</tr>
<tr>
<td>NHA</td>
<td>National Health Accounts</td>
</tr>
<tr>
<td>OECD</td>
<td>Organization for Economic Cooperation and Development</td>
</tr>
<tr>
<td>PAHO</td>
<td>Pan American Health Organization</td>
</tr>
<tr>
<td>PHR</td>
<td>Partnerships for Health Reform</td>
</tr>
<tr>
<td>PPP</td>
<td>Purchasing power parities</td>
</tr>
<tr>
<td>USAID</td>
<td>United States Agency for International Development</td>
</tr>
</tbody>
</table>
Bibliography and References

Books


Articles in Scholarly Journals


**Data for Decision Making Project**


To order the above documents, please contact:
Data for Decision Making (DDM) Project
Department of Population and International Health
Harvard School of Public Health
665 Huntington Avenue
Boston, MA 02115
tel: 617-432-4610
fax: 617-432-2181
or to connect to their website [http://www.hsph.harvard.edu/organizations/ddm/homepage.html]

**FUNSALUD**


To order the above documents, please contact:
Fundación Mexicana para la Salud (FUNSALUD)
Periférico Sur No. 4809
Col. El Arenal Tepepan, Del. Tlalpan
Mexico
or to connect to their website [http://www.funsalud.org.mx]
Ministry of Health of Botswana


Organization for Economic Cooperation and Development


To order the above documents, please contact:
The OECD Publications and Information Centre
2001 L Street N.W.
Suite 650
Washington, DC 20036-4922
tel: 202-785-6323
fax: 202-785-0350
or to connect to their website http://www.oecd.org

U.S. Government


To order the above documents, please contact:
Superintendent of Documents
Government Printing Office
Washington, DC 20402-9325
tel: 202-512-1800
fax: 202-512-2250
or to connect to their website http://www.ssa.gov

World Bank


To order the above documents, please contact:
The World Bank
Box 7247-8619
Philadelphia, PA 19170-8619
tel: 703-661-1580
fax: 703-661-1501
email: books@worldbank.org
or to connect to their website http://www.worldbank.org

**World Health Organization**


Health Organization.


To order the above documents, please contact:
WHO Publications Center USA
Boyd Publishing Co.
49 Sheridan Avenue
Albany, NY 12210
tel: 518-436-9686
fax: 518-436-7433
email: QCORP@compuserve.com
or to connect to their website http://www.who.org

Other Sources


National Health Accounts User Registration Form:

Please register me as a user of National Health Accounts. I would like to be contacted about new developments concerning National Health Accounts.

Name: __________________________
Company/Institution: __________________________
Address: __________________________

City: __________________________ State/Province: __________________________
Country: __________________________ Zip/Postal Code: __________________________
Internet Address: __________________________
Phone (Optional): __________________________

Please answer the following questions (you may attach your comments separately if you wish):

1. How did you hear about National Health Accounts?

2. What is your occupation?

3. Describe your use of National Health Accounts.

4. What do you like best about National Health Accounts?

5. What are your suggestions to improve National Health Accounts?

6. Who else might be interested in National Health Accounts?

Please send this form to:
National Health Accounts
Building I, Room 1210
Department of Population and International Health
Harvard School of Public Health
665 Huntington Ave.
Boston, MA 02115

Or e-mail this information to: pberman@hsph.harvard.edu
National Health Accounts (NHA) is a tool to organize, tabulate, and present health sector expenditure information. Developing country health sector analysts and policymakers can use NHA to assess the efficiency of current national health resource use, review allocation patterns, evaluate health financing options, and use the data to develop or reform health policy. Standard organization of NHA data also allows for cross-country comparability. The National Health Account “sources and uses” method, approached through various matrices and substeps, provides for a consistent calculation of a country’s total health expenditures, and an understanding of the flow of funds through its health care system.

The National Health Accounts methodology and computer program was developed at the Harvard School of Public Health in 1996 with support from the United States Agency for International Development. This manual provides an overview of the methodology and uses the example of one country to easily lead the user through the installation and steps of the National Health Accounts framework. The software requires a Windows 95 operating system. This user guide is available in English, Spanish, and Arabic.